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Preface

This guide serves three purposes. First, it explains how to use some popular open-source tools to make great-looking books, as print-ready PDFs,
ebooks and dedicated websites.
Second, it documents our Classic theme, a vanilla design for books that
is powerful and flexible.
And third, this guide is an example of the workflow and the Classic
theme in action.
We originally developed this workflow at Electric Book Works for
producing Bettercare books, before using it for other imprints and for
client work at Fire and Lion.
This guide to the workflow is a work in progress. You can contribute
from the project page: github.com/electricbookworks/electric-bookworkflow.
Arthur
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Quick new-book setup

This quick setup assumes you already have Jekyll (verson 3.3 or higher)
and Prince installed and working on your computer. There is more detail,
and lots of more advanced guidance, in this guide.
1. Download the Jekyll template.
2. Open _data/meta.yml and replace the sample book information there
with your series and book information.
3. In the book folder edit or remove the sample files, and add your book’s
content.
4. To modify the design, edit the .scss files for each output format in
book/styles .
5. Run the run- script for your operating system. (On OSX and Linux,
you need to give it permission.)
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Introduction

At Electric Book Works, we’d been producing books with InDesign for
years. InDesign is awesome, but it makes publishing simultaneously to
print and digital formats a real pain. No matter how we set things up,
we always ended up with separate master files: one for print, one for the
ebook, and one for the website. And keeping those in sync over time was
almost impossible.
We needed a way to instantly create PDF (for high-end, professional
book publishing), epub and website editions of a book from a single master
source. We needed great version control and cloud backup. We wanted to
be able to edit from anywhere, in a way that is easy for non-technical people to learn.
And we didn’t want to be locked into any proprietary tools, whose
price or availability could change at any time. We needed to use entirely
open technologies to ensure our content was future-proof. And we didn’t
want to develop any code that others had already developed.
We spent several years piecing together a solution, bit by bit. Eventually, we settled on a workflow that is (relatively) simple and powerful:
1. We store a book’s master files in plain text, formatted as markdown.
2. We turn that plain text into clean HTML instantly (using Jekyll).
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3. We apply different stylesheets to that HTML to get beautiful web versions, ebooks and print PDFs in minutes (using Sigil and PrinceXML).
4. Everything is stored securely with state-of-the-art version-control
(using GitHub and similar services).
Markdown is so simple that non-technical people can learn how to create
and edit it in under an hour. They can even work directly on the master
files online using Prose.
Jekyll is great at generating clean HTML in flexible ways, and has
a big, active development community and committed project owners. Is
also includes kramdown and Sass, which are critical to creating new book
designs quickly.
While PrinceXML is proprietary software, it’s our favourite implementation of the open standards for CSS Paged Media.

Alternative tools
There are several digital-first book-publishing systems around. Some are
also based on markdown, like ours. For example:
• Gitbook IO
• Penflip
• LeanPub (which uses Markua)
• PubPub
• MagicBook
• Phil Schatz’s viewer.
PressBooks, which is built on Wordpress, is a superb, affordable service.
And if you’re a serious publishing outfit, have a look at O’Reilly Atlas.
The Coko Foundation is building Editoria with their new PubSweet
framework.
For converting HTML/CSS to print PDF, we use PrinceXML, which is
proprietary. Other alternatives, which we haven’t tested or don’t yet support all the page-layout features we need, include:
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•
•
•
•
•

Antenna House, a proprietary, mature system
WeasyPrint, an open-source PDF engine in active development
Vivliostyle, which is partly open-source
PDFReactor, a proprietary PDF engine
DocRaptor, a cloud-service implementation of PrinceXML.
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Technical overview
To set up the workflow, you still have to have some technical expertise.
Once it’s set up, non-technical editorial team members with a couple of
hours training (taught or self-taught) can add and edit books in it.
The technical team members who run the workflow need to be familiar
with a few concepts and tools:
• HTML and CSS: the fundamental building blocks of almost all digital
content.
• Markdown: a simple, plain-text shortcut for creating HTML. (The
original Markdown syntax reference is the easiest intro to basic mark5
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•
•

•
•
•
•

down. We use a markdown variant called kramdown. It lets us use
attributes like classes, has a stricter syntax, and allows adding of IDs to
elements.
Sass: a way to create complex CSS from simple rules.
Jekyll: software that turns markdown and Sass into HTML and CSS.
(To learn about Jekyll, start here. If you’re installing it on Windows,
you’ll also need this guide.) From version 0.4.0, our template requires
at least Jekyll 3.2.
Bundler: software that manages which version of Jekyll (and other
Ruby gems) to apply to a project.
Git: software for tracking a team’s changes and syncing them with a
remote server. We like to use GitHub and Bitbucket as our remotes.
Sigil: an open-source epub editor, where we quickly assemble ebooks.
PrinceXML: an app for creating PDFs from HTML and CSS (Prince
is the only proprietary part of this stack).

To use the workflow on your own machine, you must have the following
software installed:
• Ruby (ideally, via a Ruby version manager like RVM or Homebrew)
• Bundler (manages your Ruby gem versions)
• Jekyll (generates your source HTML)
• PrinceXML (for generating PDFs from source HTML)
• Sigil (for finishing epubs)
• Git (or similar, if you want good version control).

Folder (repo) structure
A workflow folder (often tracked in Git as a repo) usually contains a series
of related books. Its folders and files follow the standard Jekyll structure.
We then put each book’s content in its own folder. In the template, the
first book folder is simply called book .
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Pro tip: You could also store several series in one repo, each series
with its own set of Jekyll files, and a single _prose.yml configuration in the root folder for all series subfolders. This is only useful
if you don’t need a live staging site or previews with GitHub Pages,
since each Jekyll setup must be in its own repo for GitHub Pages to
work out of the box.

Using the template
The Electric Book repo (folder) is ready to use for a series of one or more
books. In short, to get up and running, see the Quick Start guide.
Now, let’s get into some more detail about how it all works. There are
several folders and files in the series template repo:
• _config.yml : a file for setting configuration options for Jekyll, which
will compile your book for output. There are several other smaller config files you can ignore. They are for changing specific config settings
on output.
• _prose.yml : configuration settings for using prose.io for online book
editing (generally, you won’t have to edit this file).
• book : a folder for a book’s content, stored here in a series of markdown files
• _data : a folder for information about your books (aka metadata).
• _includes : snippets of HTML for Jekyll (you won’t have to open this
folder).
• _html : where Jekyll will generate the HTML versions of your books.
• _output : the folder where our output scripts will save your PDFs.
• index.md : the home page of your series when served as a website.
• various .bat , .command and .sh scripts for quickly generating
books in different formats on various operating systems.
Let’s explain some of these in more detail.
The default design, the Electric Book Classic theme gem, is imported
7
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automatically when you run bundle install .
That gem provides the basic design of your books. A theme is a collection of files (Sass, CSS, fonts, Javascript and hyphenation dictionaries)
that define a book’s design. We hope that in future we and others might
design other themes. Classic is extremely versatile and powerful already.
For most book design, you’ll only have to edit the variables in each book’s
print-pdf.scss , screen-pdf.scss , web.scss and epub.scss , and
add your own custom CSS as needed.

If you’re familiar with Sass, you’ll know that Jekyll will convert
these .scss files into finished .css files. Sass, saved in .scss
files, is to CSS what markdown is to HTML: an efficient way to
write that lets software do the hard work of creating finished code.

Creating a new book
The process of setting up a new book is covered briefly in our quick-start
section. Here is more detail.
To create a new book in a new series:
1. The repo (or series folder) can hold one book or many, like a series
of books that share similar metadata or features (e.g. they’re all by the
same author). Make a copy of the folder and, if you like, rename it for
your series. E.g. my-sci-fi .
2. Inside my-sci-fi , open and edit these three files:
• _config.yml : Edit the values there for your Jekyll setup. The comments will guide you.
• index.md : Replace our template text with your own. Usually, a
link
to
each
book
is
useful,
e.g.
[Space
Potatoes](space-potatoes) .
• README.md : Replace our template text with any notes your collaborators might need to know about your series. (The README file
is usually only read in the context of editing the files in your folder/
8
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3.

4.
5.

6.
7.

repo.)
Optionally, rename the book folder with a one-word, lowercase version of your book’s title (e.g. space-potatoes ). Use only lowercase
letters and no spaces. If you’re creating more than one book, make a
folder for each book.
In _data , edit the meta.yml file, filling in your series info and info
about at least your first book.
Inside a book’s text folder, add a markdown file for each piece of your
book, e.g. one file per chapter. Our template contains files we consider
minimum requirements for most books: a cover, a title page, a copyright page, a contents page, and a chapter.
Inside each book’s folder, store images in the images folder. Add a
cover.jpg image of your book’s front cover there, too.
In each book’s styles folder, edit the values in print-pdf.scss ,
screen-pdf.scss , web.scss and epub.scss .

Creating book content
Each markdown file in space-potatoes is a part of a book, such as a table
of contents or a chapter. Each file must start with:
-----

And between those --- s, we can and should specify some information
about that part. This information is called YAML frontmatter.
In each file’s YAML frontmatter (the info between --- s at the top) we
specify the book-part’s title and (sometimes) the book-part’s style to
use for that part. The style specifies what kind of book-part it is, such as
a title-page or chapter .
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Technical note: the style YAML sets the class attribute of the
output HTML’s <body> element. Themes use that class to control
CSS and page structure.

When you create your book, we recommend following these conventions
for file naming and YAML frontmatter style settings:
Book section

Sample file

Style in YAML

Front cover (for the ebook)

0-0-cover.md

cover

Title page

0-1-titlepage.md

title-page

Copyright page

0-2-copyright.md

copyright-page

Table of contents

0-3-contents.md

contents-page

Acknowledgements

0-4-acknowledgements.md

frontmatter

A first chapter

1.md

chapter

A second chapter

2.md

chapter

If you don’t set the style , the page will default to style: chapter . So
you actually don’t need to ever set style: chapter in a YAML header.
For most chapters in a book, then, your YAML frontmatter will simply
include a chapter title:
--title: "Chapter One: What are Space Potatoes?"
---

Page styles we’ve designed for in the Classic theme include:
• index for the home page of a collection
• cover for a front cover, which will appear in ebook editions
• halftitle-page for a book’s halftitle page
• previous-publications-page for a book’s list of the author’s previous
10
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publications
•
•
•
•
•
•
•
•

title-page for a book’s title page
copyright-page for the copyright or imprint page
contents-page for the book’s table of contents
dedication-page for a dedication page
epigraph-page for an epigraph page
frontispiece-page for a frontispiece page
frontmatter for other prelim pages not accounted for otherwise
chapter for a book’s default chapter page (and the global default)

You can also invent your own page styles, and use them in your custom
CSS instead of these, though you may get unexpected results if you’ve been
relying on a theme for existing styles like chapter .
Set ‘page number one’
Many books have two ‘page ones’:
1. the half-title or title page and,
2. if the prelims have roman-numeral page numbers, the first chapter.
You should specify those pages so that Prince knows where to start numbering when creating PDFs.
Why? Well, for example, in print output if you use frontmatter on
a book-part, by default it will have roman-numeral page numbers. When
the first chapter starts, it will have decimal page numbers. However, the
page numbering will be consecutive from roman through decimal. That is,
it will run ‘ix, x, 11, 12’. You reset the numbering to 1 at the start of the
first chapter to avoid this.
You reset page numbering by adding the class page-1 to the first
block-level element on the relevant page.
You can do this in two ways:
1. If a markdown document starts at ‘page one’, add the class to the style
YAML header. E.g.
---
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title: Half-title page
style: halftitle-page page-1
---

And at the first chapter:
--title: Chapter One
style: chapter page-1
---

Remember that chapter is the default, so you normally don’t have
to specify it. But if you want to add a class in addition to chapter ,
you must specify both classes. This is because, if you were to use
style: page-1 in a YAML header, the class page-1 would override
the default style: chapter , not add to it.
2. Alternatively, add the page-1 class to the first block-level element in
the chapter by adding the tag {:.page-1} in the line immediately after
it. But for this to work, the element must not have a CSS float applied
to it. So often this doesn’t work as well as specifying page-1 in YAML
frontmatter.
File naming
Name each book’s markdown files in perfectly alphabetical order. We recommend using a numbering system, where prelims (frontmatter) files start
with a 0, e.g. 0-1-titlepage.md , 0-2-copyright.md , and chapter files
are numbered for their chapter number, e.g. 01.md , 02.md , and so on.
The alphabetical order makes it easy to see the documents in the right
order at all times, and it makes ordering outputted HTML files easy when
dropping them into Prince for PDF output.

12
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Note: We recommend using leading zeros in file-name numbers –
that is, 02.md rather than 2.md – because that sorts correctly in
most file browsers. Otherwise, some file browsers will sort 10.md
before 2.md . In the rare event that you have over 99 chapters, use
two leading zeros: 001.md .

The images folder
Alongside the content files in a book’s folder is an images folder, for
images that belong to that book only.
A book’s folder should only ever need to contain markdown files and
images. If you’re embedding other kinds of media you could add folders
for that alongside images . We don’t recommend sharing images or media
between books, in case you want to move a book from one series to
another later. (So, for example, copy the publisher logo into each book’s
images folder separately.)
If your series home page requires images, you will need to create an
images folder for that in the main series folder.
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This guide explains how to edit text for the workflow. On its own, it’s also
a handy guide to markdown in general.
If you get your markdown right, the workflow can zap out an almost15
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print-ready PDF, website or ebook from your files in a matter of minutes.
That is, we go straight from edited manuscript to page proofs – no typesetting!
To edit for the workflow, you need to have a rough idea how HTML
works, and you need to learn markdown. If you’re new to HTML and
markdown, don’t worry: it’s much easier than you think.

How HTML works
HTML is a computer language. It’s a way for us to mark up or tag text, so
that a computer knows how to display it beautifully to humans. That is,
software (most commonly a web browser) reads the HTML code and renders it as nice-looking, readable text and images.
In HTML, each piece of content (e.g. a paragraph) starts and ends with
a tag that a computer can recognise. Tags are always in elbow brackets, like
this paragraph tag: <p> .
<p>
This text is tagged in HTML as a paragraph.
</p>

The slash ‘closes’ the tag.
The <p> tag is one of about a hundred possible tags, maybe ten of
which you’ll see in a book, such as tags for headings (e.g. <h1> , <h2> ),
bold and italic, lists, images, tables, and blockquotes.
But not all paragraphs are the same: there are opening paragraphs, pullquote paragraphs, blurb paragraphs and more. If I want to tell the computer what kind of paragraph it is, I can put it in a special class. Say, the
‘blurb’ class of paragraph. To write this in HTML, I would make the tag
<p class="blurb"> . Unlike its limited set of specific tags, HTML classes
are infinite, because we can make up class names as we need them.
HTML is very simple and very powerful (which is why it’s the language
behind almost every web page). We can mark up everything in a book
16
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using HTML tags and classes. In our workflow, we store books in HTML,
with each book part (title page, contents page, chapter, etc.) in its own
HTML file.
Then, to create print-ready PDFs, websites and ebooks from that
HTML, we combine the files with CSS stylesheets. CSS is another computer language that defines design: font sizes, indentation, colour, etc. A
CSS file will say ‘make all headings bold’, for instance, or ‘indent blockquotes by 1em’.
If we combine a book’s HTML with a stylesheet designed for print,
we can get a print-ready PDF. If we combine the same HTML with a
stylesheet for the web, we get the book as a website. This way, we only
ever store the book’s content once, and use different stylesheets to generate
alternative editions from that single source.
Unfortunately HTML tags are very, very time consuming to type by
hand. But we have a shortcut! It’s called markdown, and it’s amazing.

How markdown works
Markdown is just plain text, neatly structured. Plain text as in .txt files.
It’s so neatly structured that software can work out, just from the structure
of your text, what HTML you intended, and convert it instantly to finished
HTML, tags and all. No way! Yes way.
Markdown was invented by two very smart people in 2004: John Gruber and Aaron Swartz. Since their work, others have added new features
to markdown. So today there are many variations of markdown. We use a
variation called kramdown.
As you work with markdown, you’ll get to know it really well. That can
take as little as a few hours. And hopefully you’ll come to love it as much
as we do. To do that, you’ll need to keep the kramdown syntax reference
handy. For now, though, we’ll explain the most common, important things
you’ll need to edit simple books.
To quickly test any basic markdown yourself, go to http://kramdown.herokuapp.com. Type markdown in the left, and see the rendered
HTML on the right.
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Paragraphs
This is easy: a paragraph is a line of text separated from any other text by
empty lines.
You can even have line breaks in a paragraph, and markdown will just
ignore them (or, rather, replace them with spaces). That is, markdown is
looking for an empty line before it ends a paragraph.
This is a paragraph.
This is another
paragraph.

Result:
This is a paragraph.
This is another paragraph.
Headings
You can use up to six levels of heading, from level one to level six. To
make a heading, just put one or more hash signs, # , and a space, before
the heading. For a first-level heading, use one hash sign; for a second-level
heading, use two; and so on. Like with paragraphs, separate the heading
from everything else with an empty line space.
## This is a second-level heading
This is a paragraph.

Italics
Just put * before and after the italicised words: is it really *this*
easy? . It’s really this easy.
Bold
Just put two * s before and after the bold text: good for **shouting** .
18
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Shouting.
Lists
There are two kinds of lists: bulleted and
numbered. For a bulleted list, start each
line with a * and a tab. For a numbered
list, start each line with a number, a full
stop and a tab (you can use any number,
because the software will always create
an HTML list that starts with 1; but it’s
best to use 1 or the actual numbers you
intend, just to make things neat). Markdown:
1.

Apples

2.

Oranges

3.

Pears

*

Apples

*

Oranges

*

Pears

Tip: If you use bold in a first-level
heading

(e.g.

# **Chapter 1**

Lost at Sea ), our Classic theme’s

typography will put that bold text
onto its own line, set off from the
heading. This is useful for chapter
numbers that should look separate
from the chapter title, but in the
underlying HTML need to be part of
the heading, for instance when software generates tables of contents.

Result:
1. Apples
2. Oranges
3. Pears
• Apples
• Oranges
• Pears
Simple tables
You can create simple tables in markdown. You can make them really neat,
or you can make them really efficient. Markdown:
19
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| Fruit

| Quantity |

|---------|----------|
| Apples

| 2

|

| Oranges | 5

|

| Pears

|

| 0

| Fruit | Quantity
|---|--| Apples | 2
| Oranges | 5
| Pears | 0

Result:
Fruit

Quantity

Apples

2

Oranges

5

Pears

0

Fruit

Quantity

Apples

2

Oranges

5

Pears

0

To make more complex tables with
merged or individually styled cells, you
have to use actual HTML table markup.
See the Tables chapter for more detail.

Note the minimum three hyphens in
the lines that creates the border
between the table head and table
body. (Kramdown doesn’t require

Blockquotes
Remember how old email programs put
a > at the start of each line when you hit
20
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‘Reply’? Ah, > means blockquote. Start each line with > and a space to
make text a blockquote. Markdown:
> This is text in a blockquote.

Result:
This is text in a blockquote.
In our workflow we use blockquote HTML for more than just quotations,
though. We also use it for figures and poetry. We’ll come back to this later.
Hyperlinks
If you want your final HTML to include a clickable link:
• surround the text you want clickable with [ and ]
• put the URL it should point to between ( and ) immediately afterwards.
Markdown:
To learn more, [click here](http://google.com).

Result:
To learn more, click here.
Images
To place an image, you include a line telling the computer where to find
the image file. This looks like a hyperlink, but with a ! at the start of the
line. Inside the square brackets, you include a brief description of the image
(this is useful to screen readers for the visually impaired).
![A dog chasing a bus.](images/dogbus.jpg)

21
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In the parentheses above, the images/ part says that the dogbus.jpg
image is in the images folder, which is alongside the markdown file. In
our workflow, we always put images in the images folder like this.
See the Images chapter for more detail.
Endnotes
Endnotes in our workflow appear at the end of a document (that is, a web
1
page or a book chapter).
• put a [^1] where the footnote reference should appear (the 1 there
can be any numbers or letters, and should be different for each footnote
in a document);
• anywhere in the document (we recommend after the paragraph containing the footnote reference), put [^1]: Your footnote text
here. .
We’ll explain how to create notes on the side or bottom of a page (footnotes) later when we talk about classes.
(By the way, endnote references are <sup> in kramdown’s HTML, not
unicode numbers like ². The Classic theme includes styling for these and
for <sub> , as in H2O.)
See the Notes chapter for more detail.
Definition lists
A definition list is a list of definitions, not surprisingly. Think of a dictionary. A definition list comprises one or more entries, and each entry
has a headword and a definition. Even if you’re not editing a dictionary,
you might need to create a short glossary or define a word or two at some
point. To create a definition entry in markdown, put the headword on its
own line, and the definition on the next, after a colon and a tab. Markdown:
Editor
:

Someone who spends more time learning new tricks

than making money.

22
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Result:
Editor
Someone who spends more time learning new tricks than making
money.
To create a whole list of definition entries, just put one of these after the
other, with a line space between them.

Using class tags
We’re going to get a bit more advanced now. Get some tea.
As we mentioned earlier, sometimes we have to tell our software what
kind of paragraph or list or blockquote we want. These kinds of text are
called classes. To give something a class, we add a kramdown tag in curly
braces, with a colon, and a dot before the class name. Markdown:
This paragraph should be in a box.
{:.box}

Result:

This paragraph should be in a box.

For the resulting HTML to actually appear in a box, when we turn your
markdown into a finished book, we’ll have to combine it with a CSS
stylesheet that includes formatting instructions for the box class. If you’re
just editing in markdown, you don’t have to think about the stylesheets.
Our default stylesheets include designs for box as well as several other
classes. (Which we’ll list in a moment.)
But if your book needs classes that aren’t already supported in the Clas23
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sic theme, you’ll need to ask a CSS-savvy designer to write you some CSS
rules for your new class, to add to the bottom of your theme’s master
.scss files as custom CSS.

Inventing classes
If you invent new classes, make sure you name them for their
semantic purpose, not their appearance. For instance,
important-tip is a better class name than shaded-bold . Also,
class names should always be lowercase and have no spaces.

In addition to boxes, our default stylesheets include lots of other classes for
common book features.

Block and inline elements
Attribute tags like classes can be applied to two kinds of element:
block elements and inline elements.
A block element is anything that should (in print or on screen)
start and end with a line break, like a paragraph or a list. An inline
element is anything that appears inside a line of running text, like
bold and italic.
Most of the Classic theme’s pre-designed classes are for either
block or inline elements, and sometimes both.
When you apply an attribute tag to a block-level element in
kramdown, you put the tag on the line immediately following the
element.
When you apply an attribute tag to an inline element, it appears
immediately at the end of a span (a span is any contiguous series
of inline characters inside a block element). Spans in kramdown
can be marked off with asterisks as if they are italics: mark off the
text you’re tagging with asterisks ( * ), as you would italics, and put
your tag immediately after the closing * , on the same line. E.g.

24
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*Make this small-caps.*{:.smallcaps} . The Classic theme will

then apply the correct styling to the span, instead of the default
italic.

To see all the classes that our Classic theme supports, see the Supported
classes section.

Editing reflowable text
When you’re working in markdown, you’re creating text that might
reflow in an infinite number of ways on screens and onto page layouts.
This changes the way you edit, because nothing is static.
For instance, you can use special HTML codes to insert non-breaking
spaces, discretionary (‘soft’) hyphens and non-breaking hyphens.
I need to

Use this

Prevent ellipses falling

Add a non-breaking space ( &nbsp; ) before ellipses.

after a line break
Prevent dashes falling after Add a non-breaking space ( &nbsp; ) before the dash: the
a line break

en-dash&nbsp;– as I've explained&nbsp;– is tricky.

Prevent line breaks

Use a non-breaking space: e.g. for ‘3 pm, 24 May’ type

between numbers and

3&nbsp;pm, 24&nbsp;May

units
Prevent line breaks

Use a non-breaking space: e.g. for ‘Grade 2’ type

between adjectives and

Grade&nbsp;2

their units
Prevent line breaks inside

Use a non-breaking space: e.g. for ‘40 000’ type 40&nbsp;000

big numbers
Prevent a line break at a

Use &#x2011; for a non-breaking hyphen, e.g.

hyphen

D&#x2011;Space for ‘D‑Space’
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I need to

Use this

Allow a word to hyphenate Insert a discretionary (‘soft’) hyphen code: &shy; . E.g.
at the end of a line
1.

mark&shy;down

In kramdown syntax, unfortunately, endnotes are called footnotes; so it’s easy to confuse
them. In book parlance, there is a big difference between footnotes and endnotes.
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Supported classes

Our Classic theme includes styling for a range of classes. You can apply
these to elements in markdown.

Formatting
Use these classes in your markdown to create specific formatting effects.
Feature

Workflow class

Bibliography .bibliography

Block Explanation

Supports

or

edition

inline

suffix

Block

list

Styles a list as a

No

bibliography, for instance
at the end of an academic
book.

Box

.box

Block

Puts the element in a box, No
to set it off from the rest
of the text.
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Feature

Chapter

Workflow class

.chapter-number

Block Explanation

Supports

or

edition

inline

suffix

Block

number

Used for a chapter

No

number before a chapter
heading. (See the tip at
Bold in the chapter on
Markdown for another
way to handle chapter
numbers.

Dedication

.dedication

Block

A dedication, for instance No
at the start of a book or
chapter

Epigraph

.epigraph-source

Block

source
Epigraph

The person to whom the

No

epigraph is attributed.
.epigraph

Block

An epigraph at the start

No

of a book or chapter.
Figure

.figure

Block

A figure is an image with

No

a caption. Read about
how to manage them
properly in our workflow
guide.
Figure: extra

.x-small

Block

small

Add to the .figure tag,

No

e.g. {:.figure
.x-small} .

Figure: fixed

.fixed

Block

position

Add to the .figure tag,
e.g. {:.figure .fixed} .
For figures that must
keep their position in the
text flow, and must not
float to the top of the
page.
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Feature

Figure: large

Workflow class

.large

Block Explanation

Supports

or

edition

inline

suffix

Block

Add to the .figure tag,

No

e.g. {:.figure .large} .
Figure:

.medium

Block

medium

Add to the .figure tag,

No

e.g. {:.figure
.medium} .

Figure:

.small

Block

small
Figure

Add to the .figure tag,

No

e.g. {:.figure .small} .
.height-1 to .height-50

Block

height

Sets the height of an

Yes

element to a multiple of
the default line height.
Use in figures, on line
after image (the <p>
containing the <img> ),
to maintain baseline grid.

First

.first

Block

paragraph

For any paragraph that

No

starts a new set of
paragraphs, flush left and
with a gap above it.

Float to top

.float-top

Block

Floats the element to the

Yes

top of its page. Useful for
boxes. Applies to print
output only.
Float to

.float-bottom

Block

bottom

Floats the element to the
bottom of its page. Useful
for boxes. Applies to print
output only.
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Feature

Footnote

Workflow class

.sidenote .bottom

Block Explanation

Supports

or

edition

inline

suffix

Block

When you add .bottom

or

to .sidenote , the note

inline

appears at the foot of the

No

page in print output. It
remains on the side on
screens. (Also see the
chapter ‘Footnotes,
endnotes and sidenotes’.)
Fraction

.fractions

Block

If your font supports it,

or

converts characters like

inline

No

1/2 into fraction

characters.
Frontmatter

.frontmatter-reference

Inline

references

Tag links in the Table of

No

Contents whose page
numbers must match yout
frontmatter reference
style set in CSS.

Glossary

.glossary

Block

Use this after the last

No

entry in a series of
definition lists to define
the entire list of
definitions as a glossary.
Hide from
print

.non-printing

Block

Hides the element from

or

print output. Useful for

inline

things like clickable
buttons, which are only
intended for screens, not
paper.
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Feature

Keep

Workflow class

.keep-together

Block Explanation

Supports

or

edition

inline

suffix

Block

together

Prevents an element from No
breaking across pages.
(E.g. you want to keep a
short list on the same
page.)

Keep with

.keep-with-next

Block

next

Prevents a page break

No

between this element and
the next one.

Logo image

.logo

Block

Used for making images

No

small, especially for small
logos in text like on
acknowledgements pages.
Page break

.page-break-after

Block

after
Page break

Creates a page break after No
the element.

.page-break-after-right

Block

When applied to the very No

after, end of

last element in the book,

book

ensures a blank verso for
an even-numbered page
extent.

Page break

.page-break-before

Block

before
Page break:

Starts its element on a

No

new page.
.allow-break

Block

allow

Allows an element to
break over a page where
the default styles would
normally prevent that.
Apply the class to the
parent element.
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Feature

Page

Workflow class

.page-1

Block Explanation

Supports

or

edition

inline

suffix

Block

Restarts page numbering

numbering

from 1. Can be added to

restart

the first block element on

No

a page, or to the YAML
header, in addition to the
main style, e.g. style:
halftitle-page page-1

or style: chapter
page-1 . Recommended

for any document that
starts a book interior (e.g.
title page), to retain
correct pagination when
creating a PDF ebook
with a front cover
Poetry

.verse

Block

Designing poetry is tricky No
and important. Read
about how to manage this
in our workflow guide.

Pull quote

.pullquote

Block

Displays a paragraph as a

No

pull quote.
Sidenote

Block

A sidenote appears in a

or

sidebar to the right of the

inline

text.

Block

If your font supports

(lowercase

or

proper small-caps glyphs.

only)

inline

Only affects the lowercase

Small caps

.sidenote

.smallcaps

letters. Add .italics or
.bold if needed to

italicise or bold.
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Feature

Small caps

Workflow class

.allsmallcaps

throughout

Block Explanation

Supports

or

edition

inline

suffix

Block

If your font supports

or

proper small-caps glyphs,

inline

all characters are small

No

caps. Add .italics or
.bold if needed to

italicise or bold.
Source after

.source

Block

a quotation

The name and/or title of

No

the source for a preceding
quotation.

Table

.table-caption

Block

caption

Add {:.table-caption}

No

in the line immediately
after a table caption.
Table captions must
always appear above
tables, not after them.

Title page:

.title-page-author

Block

author
Title page:

.title-page-logo

Block

A logo, as an image, on

No

the title page.
.title-page-subtitle

Block

subtitle
Title page:

No

the title page.

logo
Title page:

The book’s author(s) on

The book’s subtitle on the No
title page.

.title-page-title

Block

title

The book’s title on the

No

title page.

Tracking:

.tighten-1 to

Block

Each increment tightens

tighten

.tighten-50

or

the space between letters

inline

by 0.001em (1/1000 of a
em). Affects print output
only.
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Feature

Tracking:

Workflow class

.loosen-1 to .loosen-50

loosen

Block Explanation

Supports

or

edition

inline

suffix

Block

Each increment loosens

or

the space between letters

inline

by 0.001em (1/1000 of a

Yes

em). Affects print output
only.
Valediction

.valediction

Block

Used for the sign-off at

No

the end of a letter, preface
or foreword.

Reserved classes
You may also need to create your own classes for other uses. If you do,
avoid using the same already-supported class names above. You should
also avoid using the following ones, which are reserved for specific structural elements.
Class name

Reserved for

index

The home page of a collection, used for the style value
in file YAML headers

cover

A front cover, which will appear in ebook editions, used
for the style value in file YAML headers

halftitle-page

A book’s halftitle page, used for the style value in file
YAML headers

previous-publications-page

A book’s list of the author’s previous publications, used
for the style value in file YAML headers

title-page

A book’s title page, used for the style value in file
YAML headers

copyright-page

copyright or imprint page, used for the style value in
file YAML headers
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Class name

Reserved for

contents-page

A book’s table of contents, used for the style value in
file YAML headers

dedication-page

A dedication page, used for the style value in file
YAML headers

epigraph-page

An epigraph page, used for the style value in file
YAML headers

frontispiece-page

A frontispiece page, used for the style value in file
YAML headers

frontmatter

For other prelim pages not accounted for otherwise, used
for the style value in file YAML headers

chapter

A book’s default chapter page (and the global default),
used for the style value in file YAML headers

The edition suffix
If you want to produce more than one print edition of a book from the
same source file, you can’t use the same classes that affect text-flow – like
.tighten-1 , for instance – in both editions, because the text will flow differently in each edition.
Our workflow has a way to manage that. In the print CSS file, you can
specify an edition suffix. For instance, if you’re producing a schools edition of a book, you might make your suffix -schools-edn . That suffix
will be appended to the end of certain class names for that stylesheet. The
default .tighten-1 class will become .tighten-1-schools-edn in your
final print CSS.
(It’s a good idea to start a suffix with a hyphen and use all lowercase letters, to keep your output CSS neat. Never use spaces.)
Only some classes are affected – see the table above for which ones.
The most important are the classes used for tightening and loosening letter-spacing, which are mostly used to control widows and orphans in print
layout.
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In your markdown, then, you’d use {:.tighten-1-schools-edn}
instead of {:.tighten-1} , and that class will then only have an effect on
your schools edition. If you had another edition, say a large-print edition
with a -large-print suffix, you’d use a {:.tighten-1-large-print} tag
in the markdown. These would match the classes automatically generated
in each edition’s CSS.
Of course, one element can carry both classes. For instance, you might
end up with a paragraph tagged with {:.tighten-1-schools-edn
.tighten-1-large-print} . That paragraph would then be tightened in
both print layouts.

Deprecated classes
Early versions of the EBW used the following classes, which are no longer
supported:
• shrink
• tighten , tight , x-tight , xx-tight , xxx-tight
• loosen , loose , x-loose

36

Tables of contents

A table of contents should be its own markdown file containing a list of
the book’s parts. Each list item should be a link to a location in the book –
ideally a fragment identifier to ensure that print page references are always
accurate. Here is a simple example:
--title: Contents
style: contents-page
--# Contents
1. [Chapter 1](1.html#chapter-1)
1. [Chapter 2](2.html#chapter-2)

For more advanced markup and styling, you may need to do more. In this
example, each element is tagged.
---
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title: Contents
style: contents-page
--# Contents
1.

[*Acknowledgements*{:.toc-chapter-title}](0-5-acknowledgements.html#acknowledg
1.
[*Preface*{:.toc-chapter-title}](text.html#preface){:.frontmatter-reference}
1. [*1*{:.toc-chapter-number} *Early Days in
Mavambe*{:.toc-chapter-title}](text.html#early-days-in-mavambe)
1. [*2*{:.toc-chapter-number} *Baragwanath Hospital and
Beyond*{:.toc-chapter-title}](text.html#baragwanath-hospital-and-beyond)

Note the .frontmatter-reference in particular: our default styles format
that page number according to the style you set for the
$frontmatter-reference-style variable in your print stylesheet. The
other classes in this example are for custom formatting.

Tip: We recommend using a numbered list, even though out
default styles hide the numbers. This is to make it easier to convert
your TOC to EPUB3, which requires that the nav element on your
contents page contains only an ordered list.
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Images

Adding images in markdown
Alternative image sets
Image placement
Preparing images
• Recommended image sizes
• Resolution
• Image styles
• Image file sizes
• Cover images
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Adding images in markdown
We use standard markdown to embed images:
![A description of the image](../{{ site.image-set
}}/filename.svg)

Let’s break that down:
• the exclamation mark and square and round brackets make up the
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masic markdown image syntax: ![Description](filename) . The
description is especially important for screen-readers used by the visually impaired.
• ../ means ‘go up, out of the text folder’
• {{ site.image-set }}/ means ‘go into the folder containing our preferred set of images’ (as defined in _config.yml ). The default imageset folder is images .
• finally, the image file name.
Many images are in figures. That is, they include an image followed by
a caption. We put these together in a <blockquote> element with a
.figure class. We can then control placement by styling the
<blockquote> .
The reason we use a blockquote is that it lets us keep images and their
captions together. A <figure> element would be better HTML, but it
won’t validate in EPUB2, and can’t be created with kramdown.
Here’s an example of markdown for a figure:
> ![Line drawing of a book](../{{ site.image-set }}/book.jpg)
>
> This is not a book.
{:.figure}

Every line (except the {:.figure} class tag at the end) starts with a >
and a space. These wrap the figure (image and caption) in a blockquote
element.
The first line is the image reference. As noted above, it consists of:
• an exclamation mark telling markdown that we’re placing an image
• the alt attribute in square brackets
• the path to the image file.
The third line is the figure caption, followed by the kramdown tag
{:.figure} , which lets our stylesheets format the blockquote as a figure. (For instance, preventing a page break between the image and the cap40
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This is not a book.
tion in print.)
This will display like this.
If your image has no caption, just skip the empty line and caption line:
> ![Figure 2-A: The Ballard scoring method](../{{
site.image-set }}/fig-2-A.svg)
{:.figure}

If it’s important to you that the image isn’t in a blockquote, and there is no
caption, you can use:
![Figure 2-A: The Ballard scoring method](../{{
site.image-set }}/fig-2-A.svg)
{:.figure}

Alternative image sets
There are often good reasons for producing books with different sets of

41

I M AGES

images. For instance, one edition may have colour images and another
black-and-white. Or your print edition might call for high-res images, but
you want low-res ones for the ebook.
By default, your markdown looks for images in the book’s images
folder. You can set your config file to switch to an alternative set of images
(in a subfolder of images ) when needed. We do this by using the {{
site.image-set }} tag to refer to whatever images folder we need at the
time.
For example:
![]({{ site.image-set }}/filename.jpg)

The default image-set is images . You can change that for each output as
needed. For instance, you might create a subfolder for high-res images in
images called print . In _config.yml you can set that subfolder as the
default images folder.
image-set: "images/hi-res"

Whenever you build your HTML, you then switch which set of images
to use by commenting out the image-set setting(s) you don’t want. For
example, when creating the high-res edition, in _config.yml you might
comment out the default image path so that the HTML uses the high-res
images:
#image-set: "images"
image-set: "images/print"

Remember that your images in your alternative images folder must have
exactly the same file names as your default image set. The HTML will be
looking for the same file names in a different folder.
To always use a specific image file for any given image, irrespective of
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the images-set config, simply hard-code your image path in markdown
– that is, without using the {{ site.image-set }} tag. For example, for
a given image you might specify the default images folder ![](images/
filename.jpg) or a specific subfolder ![](images/nb/filename.jpg) .

Image placement
You may need to control how an image is sized and placed on the page
– especially in print – depending on its detail or aspect ratio and nearby
images or other elements. You do this by adding a class tag to the line following the image or figure created with a > blockquote. (This applies a
class to the blockquote in HTML.)
In the Classic theme, you have two broad options:
The lazy way: use these class attributes:
• .x-small limits the image height. In print, to 30mm.
• .small limits the image height. In print, to 45mm.
• .medium limits the image height. In print, to 65mm, which allows two
figures with shortish captions to fit on a page.
• .large fills the width and most of a printed page, up to 150mm tall.
Try to put these images at the end of a section, because they cause a
page break.
• .fixed keeps the figure in its place in the text flow, and will not float
it to the top or bottom of a page. For instance, when an image must
appear in a step-by-step list of instructions.
You add these classes to the `{:.figure} tag like this:
{:.figure .small}
{:.figure .fixed}

and so on. You can combine size and placement classes like this, too:
{:.figure .fixed .small}

The more accurate way: use a class tag to specify the exact height of the
image in lines. This is important if you’re maintaining a baseline grid on
your pages. For instance, {:.height-5} will limit the image to a height
of five lines. Unlike the lazy way above, this tag should be applied to the
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image, not the figure. So a complete figure element might look like this in
markdown:
> ![Potatoes on the moon](Images/1-moon-potatoes.jpg)
> {:.height-12}
>
> Potatoes grow well on the moon if well watered.
{:.figure}

CSS tip: If you’re having trouble with SVGs having space around
them, in your CSS make sure you set the height of the img element. SVGs are inline elements by default, and will add white space
around them.

Preparing images
• Wherever possible, convert images to SVG so that they scale beautifully but also remain small in file-size for web use.
• Ensure that raster images, or raster/bitmap elements in SVG, are highres enough for printing (e.g. 300dpi at full size).
• Embed images placed in your SVG image, don’t just link them.
• Create a JPG version of every SVG image with the same file name
(e.g. bear.svg and bear.jpg ). You’ll need the JPG fallback for EPUB.
(We recommend JPG over GIF or PNG as a general default. One reason is that transparency seems like a good idea until your end-user
switches their e-reader to ‘night mode’, and your black line-art disappears into the background.)
• Save images in the book’s images folder.
Here’s our most common workflow for converting images to SVG:
• If the image was created in InDesign (e.g. a flowchart made of InDesign
frames): open in InDesign, group the frames that make up the image,
copy, and paste into a new Illustrator file. Adjust Illustrator file art44
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boards as necessary, then save as SVG.
• If the image was created in Photoshop or other raster format: open the
original, copy into Illustrator. Live trace the image. (We mostly use the
‘Detailed Illustration’ preset.) Save as SVG. You can also use the trace
function in Inkscape instead of Illustrator.
• If you save SVG from Adobe Illustrator (and possibly other creators,
too), choose to convert type to outlines. (For us, the main reason for
this is that PrinceXML gives unpredictable results with type in SVG.
But it’s probably safest generally to convert type to outlines for consistent output.)
Recommended image sizes
We like to use these settings where possible:
• Default width: 115mm
• Aspect ratios: 4:3 (portrait or landscape), a closer ratio, or square.
Images at wider ratios (e.g. 16:9) than 4:3 make layout more difficult.
• Therefore, maximum height is 150mm. (That’s very slightly less than a
4:3 height:width ratio.)
Using Illustrator? Different SVG editors treat image size differently. For
instance, a 2-inch-wide image in Illustrator will appear 1.6 inches wide
in Prince and Inkscape. Why? Because when creating the SVG’s XML,
Illustrator includes its dimensions in pixels, and assumes a 72dpi resolution,
where Prince and Inkscape follow the W3C SVG spec and assume 90dpi.
As a result, images coming out of Illustrator always appear 80% of their
intended size. So, if you’re creating images in Illustrator, set your image
sizes to 125% of what you intend to appear in the book. That means:
• default width 115mm × 125% = 143.75mm
• max height (at 4:3) = 190mm
Check out Adobe’s guidance on saving SVGs.
Resolution
• For SVG images, the editor you use will determine underlying resolution. Illustrator uses 72dpi, and Inkscape 90dpi. We favour and assume
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90dpi, but can rescale SVG images with our stylesheets just in case.
• For JPGs, our default resolution should be 200dpi and image quality of
80 (‘very high’ in Adobe presets). This allows for reasonable print quality while keeping file sizes sensible for web delivery. The higher resolution also allows ebook users to zoom in for more detail.
• To get a 200dpi JPG that is 115 mm wide, the image must be 906 pixels
wide. (115mm is 4.53 inches, which contains 906 pixels at 200 pixels
per inch, aka 200 dpi.)
• Try to keep JPG file sizes below 127KB: Amazon Kindle may automatically downsample images above that, and it’s better if you control
the downsampling for quality than let their servers do it. However, for
raster-only images (e.g. x-rays or photos) if a larger size is required for
acceptable print quality then larger is fine.
Image styles
We like these approaches to artwork, where possible:
• Default style: Black and white line art, with average 1mm line thickness.
• Use shades of grey only where needed, and as few shades as possible.
• Use the same font and size for all labels. (We like Source Sans Pro at
10pt on 115mm-wide images, 11pt on 145mm-wide images (see note
above on using Illustrator).
• Fit artboards to artwork bounds; there must be no white space around
the art in an image. (We control space with styling.) Since you’re creating images to a specific size, you need to expand artwork to fit the
artboard, not fit artboards to artwork bounds, which would make your
whole image smaller.
If you use live trace to create art from a raster source, you must clean up
the file to remove unnecessary fills that add to file size but do little for clarity.
Settings:
• Default file format: SVG
• Convert type to outlines (the alternative to embed and subset fonts
doesn’t work reliably in print output currently)
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• Raster elements embedded, not linked
• Transparent background
Where images must be raster (e.g. x-rays, photos), they should follow the
sizing constraints above and be saved as jpg (since Amazon Kindle only
uses JPG or GIF, avoid PNG or other formats). Save as RGB.
Where labels are added to a raster image, the image should be saved as
SVG with an embedded raster image. Labels and other text should not be
rasterised.
If you’re creating images from InDesign originals using Illustrator, a
suggested workflow:
• If the image was created in InDesign (e.g. a flowchart made of InDesign
frames): open in InDesign, group the frames that make up the image,
copy, and paste into a new Illustrator file. Adjust Illustrator file artboards as necessary, then save as SVG.
• If the image was created in Photoshop or other raster format: open the
original, copy into Illustrator. Live trace the image. I mostly used the
‘Detailed Illustration’ preset. Save as SVG.
• For filenaming, use the convention 1-2.svg, as in chapter-figure.svg.
For skills workshops images, that might be 1E-B.svg for workshop 1E,
figure B. All the images go in an images folder inside the folder with
the markdown files.
• If you save SVG from Adobe Illustrator (and possibly other creators,
too), choose to convert type to outlines. Currently, PrinceXML does
not support fonts in type in SVG reliably.
• To save a little more on file size, also convert all strokes to fills.
Image file sizes
If you SVGs seem big, read up on optimising SVGs, and/or (if you’re comfortable using Python scripts) run your SVGs through Scour.
Cover images
Add the front-cover image to the book’s images folder. Ensure colour settings are RGB and the DPI is set to 72. We recommend creating the image
in three sizes:
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•

cover.jpg : 960px high (in keeping with epub best practice these are

•
•

just under 1000px on their longest side)
cover-thumb.jpg : 300px wide
cover-large.jpg : 2000px high

The first is mandatory. The thumbnail and large images are for your convenience. For instance, when uploading a book to Amazon Kindle, you
must provide a cover image this large.

48

Embedding video

You can include any iframe in markdown to embed a video. We’ve created
a simple way to embed YouTube videos and have them look consistent
across your web version.
1. Find the video’s YouTube ID: a code in the URL that looks like this:
MqlyxZiDoOA

2. In the markdown, use the ID in this tag: {% include youtube
id="MqlyxZiDoOA" %}

This will embed the video in an iframe. (In epub output, you can replace it
with a link to watch the video online.)

Note: Our default iframe code gives the iframe a .non-printing
class, so that your theme can hide the video from the PDF edition.

For now, this only works with YouTube. If you’re embedding from any
other service, instead of using our include tags:
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• use their standard embed iframe
• try to select a width of around 850 px
• add style="max-width: 100%;" and class="non-printing" to the
iframe tag.
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Footnotes, endnotes and sidenotes

Our default theme provides three options for notes.
Footnotes appear at the end of a document (web page or book chapter). In book parlance, they are therefore actually endnotes, but we call
them footnotes because that’s what kramdown calls them. To create them
in markdown, follow the kramdown syntax for footnotes:
• put a [^1] where the footnote reference should appear (the 1 there
can be any numbers or letters, and should be different for each footnote
in a document);
• anywhere in the document (we recommend after the paragraph containing the footnote reference), put [^1]: Your footnote text
here. .
Sidenotes appear in a box to the right of the text. On wide screens, they
float far right of the text. On narrower screens, the text wraps around
them. In print, the text wraps around them, too. To create a sidenote, put
a * at the start of the sidenote text and *{:.sidenote} at the end (with
no spaces). (Technically, you’re creating an <em> span with a kramdown
IAL.)
In print, you can put sidenotes at the bottom of the page. By adding
.bottom to the {:.sidenote} tag, your sidenote sits at the bottom of
the page rather than on the right with text wrap, replicating a traditional
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footnote. So the markdown looks like this: *This is a sidenote at
the bottom of the page in print.*{:.sidenote .bottom} . On screen,
these are just regular sidenotes.
To create footnote-like sidenotes, you can tag a reference and footnotelike text to create the bottom-of-page-footnote effect:
This is body text with a footnote at the
end.[1](#fn-1){:.fnref #fnref-1}
[1](#fnref-1){:#fn-1}. This is the footnote text
{:.sidenote .bottom}

This markdown makes 1 a link in the body text, which points to the footnote text (ID fn-1 ). The number 1 at the footnote text is a link to the
reference (ID fnref-1 ).
Unlike proper kramdown footnotes, these do not autonumber. You
must manage the numbering manually. This means this is only suitable for
books that have a few footnotes. The kramdown contributors are looking
into alternative syntax that will let you place a kramdown footnote anywhere in the text.
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Tables

Kramdown (and most markdown variants) can only handle very simple
tables. For these you can create the Markdown layout manually. See the
chapter on markdown for guidance on formatting simple tables.
You can also use online tools to convert tables into a markdown format.
• Senseful. For instance, working from InDesign:
• Click and drag over some cells in the InDesign table (not the header
row). Then Ctrl+A to select the whole table.
• Ctrl+C to copy, then paste into a blank spreadsheet.
• Select all the relevant cells in your spreadsheet, and copy. The table
text is now on your clipboard, with the cells separated by tabs.
• Paste into the online Format Text as Table Input field.
• Click ‘Create Table’. (The default settings are usually fine. Play with
them only if you need to.)
• Copy the Output and paste it into your markdown file.
• Ascii Table:
• Paste tab-delimited table text
• Select ‘GitHub Markdown’ for the output style
• Copy the resulting plain-text table into your markdown.
Table formatting in markdown can differ between flavours of markdown.
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You may need to tweak it. For instance, Senseful starts some table borders
with + where kramdown needs a |. In that case, manually change the starting + in any row with a |.

Complex tables with HTML
For complex tables – anything with merged cells, for instance – you must
create an HTML table and paste that HTML (from <table> to
</table> ) into your markdown files. It’s easiest to use a WYSIWYG
HTML editor. For instance, Dreamweaver lets us paste a table from a formatted source like Word or LibreOffice, and then clean up the HTML
easily before pasting the whole <table> element into our markdown document.

Table captions
In markdown, add {:.table-caption} in the line immediately after a
table caption paragraph. This applies the class table-caption to the
paragraph, which the theme can style. For instance, in the Classic theme
print.css avoids a page break after the caption, before the table.
(According to publishing best-practice, table captions must always appear
above tables, not after them.)
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Introduction
An index (the long list with the page numbers at the end of a book) is
an important part of many non-fiction print books (many ebooks don’t
include indexes, and instead rely on ebook app’s search function). Traditionally, indexes are created by professional indexers, who read the final
page proofs and compile a list of entries and page numbers manually. They
do not only add words to the index, but entire concepts. For instance, a
good indexer will include an entry for ‘democracy’ in an index if the concept is discussed, even if the word ‘democracy’ is never used. This is why
good indexes cannot be generated by computers.
In this workflow, the challenge is in managing page numbers: our
workflow allows you to reflow the content into new formats, so page
numbers are never quite fixed. Well, you might decide that a particular
format’s pages are fixed enough for allow for manual page numbers in an
55

I ND EXES

index, but then you cannot reuse that index in another format.
So here we’ll describe how to create an index where the page numbers
are dynamic. That is, the index is a list of concepts that point to a particular
point in the book. The page numbers in the index (and clickable hyperlinks
in an ebook version) are then generated on the fly whenever you output to
PDF. This also means you can index early in the production process, such
as during editing, rather than waiting for pages to be finalised.
Note: Be careful not to confuse an index in a book with the index
page of a website. When talking about websites, the index page
is the home page of a directory. So never give your reference index
the file name index (e.g. index.md or index.html ). To avoid
confusion, in our code we refer to the reference-index when we
mean a book’s index.
To create an index you have to do two things:
1. In the text, tag the words that their index entries will point to.
2. Create an index document with a list of entries.

How to tag indexed words
To tag a word in the text, we make it a link, and we give that link:
• a target that points to the index
• a class ( .indexed ) to control what it looks like
• an ID (e.g. #democracy-1 ) to uniquely identify it.
The link target should point to the index entry for that word. This way,
clicking the word in the text will take you to the right place in the index.
And clicking the page reference in the index will take you to the word in
the text.
Here’s an example of the link in the text:
Late that night, [Bob](reference-index.html#bob-1){:.indexed
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#bob-1} realised the key was in his pocket.

And then when Bob appears later in the book:
Eventually, [Bob](reference-index.html#bob-2){:.indexed
#bob-2} called her to confess.

Note that the ID must be unique for every instance of Bob.

How to create the index list
Then in the index itself, you create a list of entries. After each entry, you
add links to each instance of that entry you’ve tagged in the text. And you
give each link the ID that you’ve pointed to in your tagged word’s link target.
Tech tip: To make it easy for us to manage, we use the same ID for
the tagged word and the index entry. You don’t have to us the same
ID. For instance, your tagged-word’s ID might be #text-bob-1
and your index entry’s link #index-bob-1 . If like us you use the
same ID in both cases, remember that your index must be in a separate file from your text, since IDs must be unique within each file.
Here is what your markdown for the index might look like. Here we’ve
included examples of sub-entries, and the tag to use for the entire list to
style it as an index: {:.reference-index} .
* Alice
[1](1.html#alice-1){:#alice-1}
[2](3.html#alice-2){:#alice-2}
* Bob
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[1](1.html#bob-1)
[2](9.html#bob-2)
* key
[1](4.html#key-1)
- private
[1](4.html#key-private-1)
- public
[1](4.html#key-public-1)
{:.reference-index}

In this example, we’ve used numbers as the link text. On screen, these will
stay numbers, e.g.:
Alice 1, 2
The stylesheet will add the commas between entries (so you could
globally replace with semicolons or otherwise). In print output (using
PrinceXML), the stylesheet will replace those numbers with page references.

Future development
We hope to find more concise ways to create indexes from tags in running
text in future. We’d also like to align this work the IDPF’s recommendations on indexes in ebooks.
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Advanced poetry markdown
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Basic poetry markdown
Encoding poetry can be tricky. Usually, poetry in HTML is structured by
tagging each stanza as a paragraph, with line breaks after each line. You
can do this by adding markdown line breaks (with double spaces or \\ at
the end of each line) and tagging the paragraph with {:.verse} . However, this structure meaks it impossible to have browsers, ereaders and
PDF engines correctly indent runover lines (because there is no nth-line
selector in CSS, unless you resort to a Javascript method that will bloat
your code and won’t run on many ereaders).

Tech note: Some text and code editors (e.g. Atom) strip out spaces
at the ends of lines automatically. So use \\ for line breaks, not
double-spaces.
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We prefer another approach: the poem is an unordered list ( ul ) and each
line (including each blank line between stanzas) is a list item ( li ). We just
hide any list markers (bullets) with list-style-type: none . This way,
we can control indents on runover lines. This is a non-semantic use of
HTML, since a poem is technically not a list. But it’s a healthy hack with
universal browser and ereader support.
Our convention is to mark each line of a stanza with a hyphen - , and
tag the list with {:.verse} :
-

I wandered lonely as a cloud

-

That floats on high o'er vales and hills,

-

When all at once I saw a crowd,

-

A host, of golden daffodils;

-

Beside the lake, beneath the trees,

-

Fluttering and dancing in the breeze.

{:.verse}

We can also indent individual lines, where the poet wanted indents, by
tagging individual list items.
-

Alas for man! day after day may rise,

-

{:.indent-3}Night may shade his thankless head,

-

He sees no God in the bright, morning skies

-

{:.indent-3}He sings no praises from his guarded

bed.
{:.verse}

The 2 in {:.indent-2} refers to the number of em spaces to indent
by. Our CSS allows for indents from 1 ( {:.indent-1} ) to 30
( {:.indent-30} ).
(Big gaps between words in a line must be created with &emsp; in the
poem text.)
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Advanced poetry markdown
But wait, there’s more! Best practice for poetry layout is that – in print – a
poem should be centered on its longest line. That is not centering the lines
of poetry, but placing the left-justified poem in the horizontal middle of
the page. Put another way, the poem should be indented till its longest line
is centered on the page.
To achieve this, put the entire poem, including its title, in a blockquote,
by adding > to the start of each line. Tag the whole blockquote as
{:.verse}, too. Finally, decide how wide you want the poem to be in multiple of 10 per cent. That is, if you reckon this poem’s longest line reaches
across 90 per cent of the page, use .width-90 .
> -

### To One Who Has Been Long in City Pent

> -

To one who has been long in city pent,

> -

{:.indent-2}'Tis very sweet to look into the fair

> -

{:.indent-2}And open face of heaven,—to breathe

a prayer
> -

Full in the smile of the blue firmament.

> -

Who is more happy, when, with heart's content,

> -

{:.indent-2}Fatigued he sinks into some pleasant

lair
> -

{:.indent-2}Of wavy grass, and reads a debonair

> -

And gentle tale of love and languishment?

> > -

Returning home at evening, with an ear

> -

{:.indent-2}Catching the notes of Philomel,—an

eye
> -

Watching the sailing cloudlet's bright career,

> -

{:.indent-2}He mourns that day so soon has glided

by:
> -

E'en like the passage of an angel's tear

> -

{:.indent-2}That falls through the clear ether

silently.
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> {:.verse}
{:.verse .width-90}

In verse structured as a list like this, our CSS preserves white space. That
is, if you type, say, three spaces you get three spaces. Normally, HTML collapses multiple spaces into one – which is great except when you want to
deliberately use extra spaces, as some poets do. However, this doesn’t work
at the start of lines, where markdown strips leading spaces. There you
must use HTML space entities (like &emsp; ) or our indent tags explained
above.
However, the whitespace: pre-wrap CSS we use for this is not currently supported on Kindle. If that’s important, it’s best to stick to using
HTML space entities like &emsp; .
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In print output in the Classic theme, the YAML header’s style setting
determines how the pages are numbered:
• all book parts set to style: frontmatter have roman-numeral page
numbers;
• all book parts set to style: chapter (or, since that’s the default fallback, all those without a style setting) have decimal page numbers;
• other book parts (e.g. style: copyright-page ) have no page numbers (nor any other headers and footers).
So if you use frontmatter on a book-part (e.g. for a preface, foreword or
acknowledgements section), by default it will have roman-numeral page
numbers. And when the first chapter starts, that chapter will have decimal page numbers.
However, the page numbering will increment consecutively from
roman to decimal, unless you tell PrinceXML to start from 1 at the first
chapter . That is, ‘ix, x, 11, 12’. To reset the numbering to 1 at the start of
the relevant chapter , you have two options:
1. Add the page class .page-1 to the first element (e.g. the first heading)
of the first chapter. In markdown, you do that with the tag
{:.page-1} in the line immediately after the heading. This only
works if that element is not set to float in the CSS. (That is, the ele63
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ment must appear in the normal flow of text.)
2. Add page-1 to the style YAML setting, in addition to specifying
chapter , not overriding it. That is, the first chapter in your book
should have the YAML style set as: style: chapter page-1 .
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Using Javascript

Wherever possible, we like to create books without Javascript. Printing
and ebooks is simpler without it, and it can quickly bloat websites. That
said, if you need to use Javascript, it may be best to place scripts in each
book’s own js folder.
To add them to your <head> elements, link to them by adding
<script> tags to _includes/head-elements . You can also link to
remote scripts here, without the need to place the actual scripts in the js
folder.
Keep in mind that anything you add to head-elements will be added
to all books in the series folder. If necessary, advanced Jekyll users can
try applying different scripts to different books by using Liquid logic tags.
For instance, if page.path contains book , where book is your book’s
folder.

65

Converting from InDesign

Suggested steps
Search-and-replace in InDesign
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Suggested steps
This is what we do when we convert one of our textbooks from a traditional InDesign workflow to markdown for this workflow. You’ll probably develop your own process for turning existing books into markdown.
Maybe this will help.
1. Open the InDesign file and copy all the text.
2. Paste the text with formatting into your text editor.
3. Search and replace (S&R) all line breaks with double line breaks:
• Tick ‘Regular expression’ (because you’re using the regex \n to
mean ‘line break’, not actually searching for the characters ‘slash’
and ‘lowercase en’).
• Find \n
• Replace with \n\n
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4. Comparing to a laid-out, up-to-date version of the book, mark all
headings with markdown’s heading hashes (#) according to their heading level. E.g.:
• h1 = #
• h2 = ##
• h3 = ### , and so on.
5. At the same time, you may want to manually create Markdown lists
using * for bullets and 1. , 2. , 3. etc. for numbered lists. Note
that list indents can get complicated, so check previous chapters and
test your markdown-to-HTML conversion when you hit a tricky one
(e.g. a note inside a bullet list nested inside a numbered list).
6. Add Markdown image references. See the images section below for
detail on how best to do this.
7. Search for every instance of italic, bold and bold-italic, and manually
mark these in markdown with asterisks: in markdown, *one
asterisk* is italic, **two** is bold, and ***three*** is bold-italic.
Remember that in some fonts, italic and bold may have different names
in InDesign, like ‘oblique’ and ‘black’.
8. Look out for special characters, especially degree symbols (°), superscripts and subscripts. It’s best to search the InDesign document (search
by style and basic character formats, e.g. ‘Position’ for superscript and
subscript) for these instances so you don’t miss any. Most superscripts
and subscripts in InDesign and similar are created by formatting normal text. In text-only, there is no formatting, so you should use the unicode character for each superscript or subscript character. E.g. when
typing the symbol for oxygen, O₂, the subscript 2 is ₂, unicode character
U+2082. To type these characters, you may need special software (e.g.
for Windows, Google unicodeinput.exe), or copy-paste from an online
reference. In Windows, you can also find symbols in Character Map,
e.g. search in Character Map for ‘Subscript Two’.

Search-and-replace in InDesign
InDesign is great for prepping text you’ve received in InDesign or Word,
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because it has very powerful search-and-replace. In particular, it’s worth
getting to know GREP search-and-replace. The learning curve is steep, but
your conversions will be much faster once you’ve mastered GREP. Here
are some GREP learning resources.
For instance, if you want to convert all italics to markdown:
1. In the Find dialog, choose GREP.
2. Click in the Format box and set the font style to Italic.
3. In the Find box, search for (.+) .
4. In the Replace box, replace with *$1* .
Remember that search-and-replace is rarely flawless, so proceed with caution. For instance, regarding italics: in markdown, it’s very important that
the starting * and ending * that mark the italics are right up against the
words they wrap. I.e.:
• Correct: I want to *emphasise* this.
• Incorrect: I want to *emphasise *this.
However, many (human) editors often mark the spaces on either side of a
word as italic, probably because clicking and dragging with a mouse can be
inaccurate, and because double-clicking a word often highlights the word
as well as the space after it. This means that when we automate ‘search for
italics and wrap with * ’, we end up wrapping the space into the markdown as well. Also, sometimes spaces in the manuscript are italic, even
though the words on either side of the space are not (this is probably
caused by editing or pasting phrases that were once italic). In Word and
InDesign, you’d never spot those italic spaces by eye. But in the markdown,
you end up with this:
I went to* *the shops.

Markdown reads that is meaning that there is an actual asterisk after
‘to’, and italics start from ‘the’ and continue (at least) to the end of the paragraph:
I went to* the shops.
These problems have to be fixed with a combo of clever searches and
manual spotting.
The same thing happens with bold, but luckily bold is usually used
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more sparingly than italic, and is therefore easier to fix manually.
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Introduction
We use PrinceXML to turn Jekyll’s HTML into beautiful, print-ready
book files. We haven’t found anything as good as Prince, so we reckon it’s
worth its price tag. And you can use the trial version to get your print output perfect before committing to the price. So our CSS files for print are
designed specifically for Prince.
If you want to learn about using CSS to control print output using
Prince, this is a great tutorial.
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Quick output
Run the template’s -pdf script for your operating system. For these to
work, you must already have Jekyll and Prince installed and working.
• On Windows, run win-print-pdf.bat by double-clicking it from
your file explorer.
• On Linux, run linux-print-pdf.sh . You may have to run it from a
terminal, and first enter chmod +x linux-print-pdf.sh to give it permissions, then bash linux-print pdf.sh .
• On Mac OSX, double-click mac-print-pdf.command in Finder. You
may need to give the file permission to run first. To do this, in a
Terminal in the same folder as the script, type chmod +x
mac-print-pdf.command .
The same applies to the other scripts (e.g. -screen-pdf ).

Detail
Creating PDF files with the Prince GUI
1. Find your book’s HTML files in your _html folder. (Remember to
run Jekyll locally to generate the latest version; if you’re getting your
HTML from a GitHub repo’s _html folder, trust that the last contributor synced up-to-date, reliable HTML generated by their local Jekyll
instance.)
2. Drag the HTML files into Prince. Make sure they’re in the right order.
Only include the files you need in print. For instance, you’ll usually
leave out index.html . You’ll usually only include cover.html when
creating a PDF ebook.
3. Tick ‘Merge all…’ and specify an output file location and name. Do
not let Prince output to your _html folder. (If you skip this, Prince
will output to your _html folder, which will cause permissions issues
when you want to modify or delete the file, because Jekyll owns the
_html folder and can overwrite it, and because Git will try to commit
and sync the output PDF, which you probably don’t want.)
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4. Prince will find your book’s print CSS, which you specified in
_config.yml . If you want a PDF with a completely different CSS file,
either:
• change it in _config.yml and restart Jekyll to update your files
with the new config, or
• leave it blank ( stylesheet-print: "" ) and manually add the output CSS to Prince.
5. Click Convert.
Tech detail: Our default HTML head includes links to both the
screen stylesheet and the print stylesheet specified in _config.yml .
Prince knows which one to use because they’re specified with
media="screen" and media="print" .
Creating PDFs with Prince from the command line
For general instructions, see the official PrinceXML user guide. We like to
use this workflow:
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1. In each book’s folder (alongside the markdown) we keep a file called
file-list . The file-list file is just a list of the HTML files that
must be included in the print PDF. E.g.:
0-1-titlepage.html
0-2-copyright.html
0-3-contents.html
1.html
2.html
3.html

If you include the list of files for a given output format in meta.yml ,
this file is automatically generated by the default file-list file in our
template.
2. At your command prompt, navigate to the book’s folder in _html .
(With the right settings, you can launch your command line app in the
right folder from a file explorer in Windows, Mac and Linux.)
3. At the prompt, type prince -l file-list -o /temp/filename.pdf .

In that last step, /temp is an existing folder at the root of your
drive (e.g. C:/temp if you’re working on your C drive in Windows) and filename is a sensible file name. If you just used
filename.pdf without the folder path, the PDF would be saved
to the same folder as the HTML in _html . We don’t recommend
this because Jekyll will overwrite that whole folder if you build new
HTML, and you’ll lose your PDF.

Refining print layout
You will doubtless want to refine your print layout by editing your markdown and adding custom CSS to the print.scss file in your theme.
For instance, to save widows and orphans, when using the Classic
theme, you can tighten letter-spacing by adding {:.tighten-5} and
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{:.loosen-5} tags to the lines after paragraphs. The number in the tag

refers to how many thousands of an em you’re affecting letter-spacing by.
For instance, {:.tighten-10} will tighten letter-spacing by 10/1000 em.
In good typography, you should avoid tightening or loosening by more
than 10/1000 wherever possible.
And to add manual hyphens to improve spacing, use discretionary
hyphens (aka soft hyphens) by adding the HTML entity &shy; where you
want the soft hyphen.
Faster print refinement
When refining print layout (e.g. fixing widows and orphans) with the
EBWorkflow, this is happening:
1. You edit the markdown
2. Jekyll generates new HTML
3. You convert to PDF in Prince
4. You open the new PDF to see your changes.
There are two delays in this process:
1. Jekyll can take several seconds to regenerate the entire book (even with
--incremental enabled)
2. You have to click ‘Convert’ and Prince must regenerate the file(s)
3. If your PDF viewer locks the file you’re viewing, you have to close it
before generating a new PDF in Prince.
To speed this up:
1. Temporarily stop Jekyll generating any files you aren’t working on. In
_config.yml , add a line that excludes those files. In this example, I’ve
listed the CSS folder and all my book’s chapters, and them commented
out with # the one I’m working on, so that Jekyll does regenerate that:
# Jekyll will ignore these files and folders.
# Useful for temporarily speeding up processing for
particular files.
exclude: [
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css,
book-one/0-0-cover.md,
book-one/0-1-half-title.md,
book-one/0-2-titlepage.md,
book-one/0-3-copyright.md,
book-one/0-4-contents.md,
#book-one/1.md,
book-one/2.md,
book-one/3.md,
]

2. Using Prince there isn’t a universal way to speed up conversion, except
to only convert the files you really need to be working on. For instance,
in your file-list , comment out files you’re not working on; or if
you’re generating your file-list from a list in meta.yml , comment
out the relevant lines there. (Also, if you’ve used Javascript in your
HTML, that can slow Prince down. We wrap scripts, like Google Analytics tags, in a test that checks for Prince.)
3. Use a PDF Viewer that doesn’t lock the file.
• On Windows, Sumatra is perfect for this, unlike Acrobat and Windows Preview, which locks the file. If you edit/regenerate a PDF it
has open, Sumatra will allow that to happen and will automatically
reload the new file, at the same page you had open.
• On Mac OSX, Preview does the same, though we’ve found it doesn’t
open the regenerated file to the page you were on, sending you back
to the start of the book, which is a pain. A much better alternative
on OSX is Skim, an open-source PDF reader. In its Preferences >
Sync, set Skim to watch for file changes and update automatically.
You may also want to set PDFs to open to the last viewed page in
Preferences > General.
Managing hyphenation in Prince
Our default stylesheets ask Prince to hyphenate paragraphs and lists ( p,
ul, ol, dl ), with a few exceptions (such as text on the title and contents
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pages). Prince includes a range of hyphenation dictionaries by default,
which do a good job. However, you might need to add dictionaries or
lists of specific words that Prince doesn’t support. You can find .dic files
online for various languages and specialities, or you can compile your own.
We provide a blank .dic file for you to add your own list of hyphenation rules to. It is at css/dictionaries/hyph.dic . Our print.css asks
Prince to look here when hyphenating.
A .dic file is a plain-text file with one word or word-fragment on
each line. Each one is called a pattern.
• If the pattern starts with a . , it will apply to, or match, any word that
starts with that pattern. E.g. .foo will match the words ‘food’ and ‘foobar’ but not ‘fastfood’.
• If the pattern ends with a . , it will apply to any word that ends with
that pattern. E.g. port. will match ‘port’ and ‘sport’ but not ‘portico’.
• Thus, if the pattern starts and ends with a . , it will apply to only that
pattern exactly. E.g. .port. will only ever match ‘port’.
To show where a word or word-fragment can hyphenate, you add digits (1
to 9) to the pattern. The digits have special meanings:
• Insert odd digits (1, 3, 5, 7, 9) where the word may hyphenate.
• Insert even digits (2, 4, 6, 8) where the word should not hyphenate.
• The higher the number, the more important the rule. That is, a 1
says ‘hyphenate here if you must’, but a 9 says ‘this is the best place to
hyphenate’. A 2 says ‘don’t hyphenate here if you can help it’, but an 8
says ‘Do not, not, not hyphenate here.’
For user discussion, see the Prince forums here: If you need to hack
Prince’s built-in hyphenation dictionaries more deeply, see this forum
post.

77

Epub output

Quick output
Assembling the epub
• Quick-epub process checklist
• Splitting large files
Mobi conversion
EPUB3 conversion
Adding iBooks display-options file

79
80
83
83
85
85
86

Quick output
On Windows, generate HTML for epub by running win-epub.bat ,
which you’ll find in the series root folder. Just double-click it from your file
explorer. For it to work, you must already have Jekyll installed and working.
The script tells Jekyll to compile epub-ready HTML, opens Sigil, and
opens 0-0-cover.html there, which automatically imports your book’s
metadata into the epub. It also opens a file browser to the epub-ready
HTML files.
In Sigil, then, add the remaining content files, define file semantics, and
generate a TOC.
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For OSX and Linux (until we create similar scripts): in a terminal
in the same folder as the scripts, run bundle exec jekyll b
--config="_config.yml,_config.epub.yml" . Then from Sigil, open the
0-0-cover.html file in _html/book/text . That will import book metadata, and you can then assemble the epub in Sigil.

Technical background: To get the metadata to import to Sigil, you
must open one of your book’s HTML files in Sigil (the cover is
best, since it’s the first file). That is, don’t ‘Add Existing Files…’ to a
new, blank epub. Only by opening a single HTML file (as in ‘File >
Open…’, then select the HTML file) will Sigil read and import the
file’s Dublin Core metadata. After that, you can add the remaining
files in Sigil using ‘Add Existing Files…’.

Assembling the epub
We like to assemble our epubs (as EPUB2 for compatibility with older
ereaders) in Sigil. If we’re not changing something major, it takes five minutes. (See the pro tip below for an even quicker way.)
1. Put the HTML files from _html into your Text folder.
2. If it’s not automatically imported, put the finished epub.css (from
your book’s styles folder in _html ) into your Sigil Styles folder.
(Our epub.css file is not the same as web.css . It does not link to font
files and avoids CSS3 features, like @fontface, some pseudo classes and
media queries, to work better with popular readers with poor or buggy
CSS support, such as Adobe Digital Editions.)
3. Replace any SVG images in the Images folder with JPG equivalents.
And:
4. Search-and-replace any links to .svg in your HTML files with .jpg.
5. Copy any fonts into the Fonts folder, if you want them embedded.
(If you don’t want to embed fonts, remove any @font-face rules from
your stylesheet to avoid file-not-found validation errors. We don’t rec80
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ommend embedding fonts unless they are required for meaning or
unusual character sets.)
6. Remove videos in iframes (iframes are invalid in EPUB2 XHTML
1.1). We recommend replacing videos with a link to an online version,
e.g. to a YouTube page. This is best done manually. Search for
videowrapper to find instances of embedded videos. To replace the
standard video wrapper with a link to the video:
• Search (with DotAll regex) for:
(?s).<div class="videowrapper
non-printing">(.*)src="(.*?)"(.*)</div>(.*?)<!--.videowrapper-->

This will find the videowrapper and store the URL of the embedded
video in memory.
• Replace with
<a href="\2" class="button">Watch</a>

This will replace the entire wrapper with a link to the same iframe
URL it memorised (at \2 ). Replace Watch with whatever phrase
you want to be the clickable text.
7. If your book includes endnotes (kramdown footnotes), replace fnref:
with fnref- and fn: with fn- . ( Background: If you have a colon in
any element ID – for instance if you’ve used kramdown’s footnote syntax – EpubCheck will return an ‘invalid NCName’ error. You need to
replace those colons with another character. If your invalid IDs follow
a set pattern (as kramdown’s footnote references do), you can replaceall quickly.)
8. Check your epub’s metadata using Sigil’s Metadata Editor, and edit
if necessary. Include at least:
• title: subtitle
• author
• date of creation
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• publisher
• ISBN (or other identifier like a UUID)
• Relation ISBN (if any; we use the print ISBN as a parent ISBN)
9. Add file semantics (right click the file name in Sigil for the semantics
context menu) to:
• key HTML files
• the cover JPG.
10. Generate the epub’s table of contents (Tools > Table Of Contents…). This TOC is generated only from the headings ( h1 to h6 )
in the text. So it does not include the cover, which has no heading, or
any other files without a heading (e.g. sometimes the copyright page).
If you need to add a cover to the TOC:
a. Go to Tools > Table Of Contents > Edit Table Of Contents…
b. Click on the first entry in the TOC list.
c. Click ‘Add Above’.
d. Click ‘Select Target’ and select the cover HTML file (usually
0-0-cover.html ).
e. In the blank space under ‘TOC Entry’, double-click and type ‘Cover’.
f. Click Okay.
g. Use the same process for adding any other files you need to add to
the TOC.
11. If fonts are important (you’ve either embedded fonts or the difference
between serif and sans-serif is semantically significant), add iBooks
XML. (See below for detail.)
12. Validate the epub in Sigil and fix any validation errors. Sigil let’s some
things past that EpubCheck flags, so also validate with EpubCheck
directly. You can use:
• the IDPF’s online version of EpubCheck
• epubcheck installed locally, and run from the command line; or
• pagina EPUB-Checker.

Tip: If you get validation errors about images, check that your paths
to images are correct and case-sensitive. For instance, Sigil needs

82

ASSEMBLI NG TH E EPUB

images to be in Images not images .

For general guidance on creating epubs with Sigil, check out EBW’s training material and the Sigil user guide.
Quick-epub process checklist
Here’s a handy checklist for assembling an epub in Sigil:
1. File > Open… and select the first HTML file in _html/book/text .
(Our -epub script does this itself).
2. Right-click the Text folder > Add Existing Files… and select the
remaining HTML files for the epub.
3. Right-click the Text or Styles folder > Add Existing Files… and select
the epub’s CSS file from _html/book/styles .
4. Tools > Table Of Contents > Generate Table Of Contents
5. Add file semantics (right-click HTML files > Add Semantics… and
right-click the cover jpg > Cover Image).
6. Save, and validate with the Flightcrew plugin and separately with
EPUBCheck.
Depending on your needs, you may also need to:
• search-and-replace (as described above) for SVG images, footnotes, or
video;
• add the cover (or other files) to your table of contents (as described
above)
• add font files if you’re embedding fonts;
• split large files (as described below)
• add the iBooks display-options XML (as described below).
Splitting large files
If you have very large text files that, in the epub output, you’d like to split
up into separate HTML files, Sigil can help. Using this tag in HTML, you
can mark where Sigil must split your HTML file(s):
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<hr class="sigil_split_marker" />

To create that in markdown, use a three-asterisk divider with a
sigil_split_marker class, like this:
***
{:.sigil_split_marker}

Also, remember to hide those markers in print output (and web and elsewhere as needed) with this in your CSS:
.sigil_split_marker {
display: none;
}

Then, when you’re assembling the epub in Sigil, just run Edit > Split At
Markers.
Sigil will then split the HTML file into separate HTML files at the
markers, and remove the <hr> element.
A common use case for this is books with end-of-book endnotes. To
create end-of-book endnotes using kramdown footnotes you must put all
content with endnotes in one markdown (and therefore HTML) file. This
file is too large for sensible epub use, so splitting is important. Sigil is smart
enough to update your internal links when you run ‘Split At Markers’.
NB: Before running Split At Markers: save, close, and reopen
your epub. At least till Sigil 0.9.3, there is an issue with updating
internal links when using Split At Markers. In order for internal
links to update correctly, Sigil must first have rewritten all link
paths to HTML files according to its ../Text/ folder structure
(e.g. the links to chapters in a Table of Contents file). Sigil only
rewrites all these paths when an epub file is opened. So to make sure
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links are udpated when running Split At Markers, you need to save,
close, and reopen the epub first. This may be fixed from Sigil 0.9.5.

Mobi conversion
These days, you should not need to create a mobi file for Amazon. It’s better to upload an epub and let Amazon convert it.
If you really do need a mobi file, we recommend putting your EPUB
into the Kindle Previewer, which automatically converts to mobi using
Kindlegen and saves the mobi file to a folder beside your epub.
If Previewer cannot convert the epub, we’ve found that adding it to
Calibre first, then (without converting) give Calibre’s version to Kindle
Previewer. Calibre gives you greater control over specific ebook conversions, but we’ve found Kindle Previewer converts some CSS better (e.g.
floats and borders).

If you need to dig into a mobi file’s code to troubleshoot, try the
KindleUnpack plugin for Calibre.

EPUB3 conversion
To convert an EPUB2 to EPUB3 in Sigil, use Kevin Hendricks’ EPUBitizer plugin.
Note that EPUB3 prefers all files to have .xhtml filename extensions,
while Jekyll uses .html . So, before you run the EPUB3-itizer:
1. Make sure your EPUB2 validates under FlightCrew and EpubCheck
2. In Sigil’s BookBrowser window select all .html files
3. Right click on your selection and select Rename
4. In the “Rename Files Starting At” dialog, remove everything and
replace it with .xhtml and click “OK”.
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Adding iBooks display-options file
If you need to add the com.apple.ibooks.display-options.xml file to
your epub for iBooks display options, you can use the AddiBooksXML plugin in Sigil.
A very basic display-options file contains this XML:
<?xml version="1.0" encoding="UTF-8"?>
<display_options>
<platform name="*">
<option name="specified-fonts">true</option>
<option name="interactive">false</option>
<option name="fixed-layout">false</option>
<option name="open-to-spread">false</option>
<option name="orientation-lock">none</option>
</platform>
</display_options>

The file should be in the epub’s META-INF folder, which Sigil does not let
you edit by default, hence the need for the plugin.
To install the plugin:
• Download the zip file.
• In Sigil, go to Plugins > Manage Plugins.
• Click Add Plugin and locate and select the zip file you downloaded.
To use the plugin:
• First,
in

a

plain-text/code

editor
create
an
com.apple.ibooks.display-options.xml file containing only the
XML shown above. If necessary, change the five options settings in it.
Save the XML file with your source material for the book for future
use/reference.
• In Sigil, with the epub open, go to Plugins > Edit > AddiBooksXML
and find and select the com.apple.ibooks.display-options.xml file
you just created.
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Markdown
Use a good text editor that colour-codes markdown as you work. We like
Sublime Text (with MarkdownEditing installed and set to MultiMarkdown) or Notepad++ (with this markdown highlighter).
• If you’re working on Windows, set your default character encoding for
your documents to ‘UTF-8 without BOM’, aka UTF-8, and not a ‘UTFwith-BOM’ option. (Jekyll will break if you don’t.)
• To check how your markdown converts to HTML while you work,
you can use this Online Kramdown Editor by Daniel Perez Alvarez.
• Keep the kramdown quick reference handy.
• In lists, kramdown lets you use a space or a tab between the list marker
(e.g. * or 1. etc.) and the list text. If only to solve an issue with nesting blockquotes in lists, use a tab between the list marker and the start
of the list text, and the same tab at the start of the blockquote line. That
is, the indentation (the tab) must be exactly the same for the blockquote
to nest correctly in the list. (A local Jekyll instance may correctly parse
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nested lists even with a space after the list marker and a tab before the
blockquote > . But GitHub Pages is much stricter and requires exactly
the same indentation.) E.g. see our book Newborn Care 12-5.
• Keep spans within block elements. For instance, if you have two paragraphs in italic, don’t start the italics with * in the first paragraph and
end the span with a second * in the next paragraph. The HTML needs
one span (e.g. <em> span) in the first para, and another in the second para. The converter isn’t smart enough to split your intended italics into two spans. Rather end the first span in the first para, and start
another one in the second.

Jekyll and GitHub
• When running Jekyll locally, and if your repo is a project using GitHub
Pages (not an organisation or user site), you’ll need to add --baseurl
'' when running Jekyll at the command line. Here’s how and why.
• You may get different results between a local Jekyll install and GitHub
Pages, even if both are using kramdown. Always check (at least spot
check) both places.
• Jekyll may break if you use a colon ( : ) in YAML frontmatter like
a title. For instance, title: Beans: The musical fruit . While you
can either use another character (e.g. title: Beans—The musical
fruit or the HTML &#58; for the colon, title: Beans&#58; The
musical fruit ), it’s easier to just wrap your title in double quotes:
title: "Beans: The musical fruit" .
• We recommend setting .gitignore to ignore the _html folder,
where Jekyll will store HTML output locally. If you choose not to
.gitignore your _html folder, it’ll contain (and sync to GitHub)
your local machine’s most recent Jekyll HTML output. (The _html
folder has nothing to do with what GitHub Pages publishes.) In theory,
committing the _html folder makes it easy for collaborators without
Jekyll to grab a book’s output HTML from the repo. But it comes with
problems: committers have a responsibility to make sure their Jekyll
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instance does a good job, and that their _html output is up-to-date
with the latest changes to the underlying markdown. Importantly, if
you have more than one committer on a book, you’ll get lots of merge
conflicts in the _html folder, and this will make your head hurt.
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